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This method is useful because it can be utilized to calculate a torque for an arbitrary angle

and an arbitrary strain. Also, since a polynomial is being approximated for the strain at an

arbitrary angle, small errors in measurements will be averaged out. One of the downfalls

of this method is due to the fact that only a single channel is used for data. Another

problem with this method is that the coefficient is calculated for a known chainring, and

does not apply to both like the system of equations method.

P3 Strain Indicator

Software for use and manual found on IGROUPS under ME and P3.

Special Thanks to Russ Janota for his help and support.
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degrees, and can be approximated by two polynomial equations. Staying within the

reference frame of either above or below 180 degrees, two polynomial equations can

approximate the maximum strain and a reference strain at an arbitrary angle in the

reference range as seen in the following equations:

This will provide two sets of two polynomial equations for the angles above 180 degrees

and the angles below 180 degrees. Then, since the relationship between strain and weight

is linear, these two polynomial equations within each set can be linearly interpolated for

an arbitrary strain using an equation of the following format:

This weight can finally be used to calculate the torque for an arbitrary strain and arbitrary

angle within the reference range as seen in the following equation:

Two three-dimensional equations for angles above 180 degrees and below 180 degrees

with two variables of angle and strain have now been formulated. However, these

equations can be further simplified and combined by solving for a constant angle. This

will provide two coefficients that can be calculated using the following format:

These coefficients can then be used to calculate the torque for an arbitrary strain at a

known angle using the following equation:
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chainring by the slope of this graph to acquire the unknown torque, as seen in the

following equation:

Using this derivative, the slope of each channel can be calculated to achieve a set of 

coefficients. To minimize error, a range of torques can also be selected with which to

calculate this slope.  If each channel is treated as a resistor in a parallel electrical circuit,

an overall coefficient can be calculated using the following equation:

The final coefficient can then be simplified and expressed in terms of torque and strain as

seen in the following equation:

This coefficient is then used in the following equation to calculate the torque for arbitrary

strains on each channel at a defined angle:

This method is very accurate because it factors in each available channel. Also, since all

the strains are added together, any channel that is more sensitive or produces higher

values will have a greater effect on the final calculation. The only downfall of this

method is that the coefficient is calculated for a known chainring, and does not apply to

both like the system of equations method.

Equation Fitting

When plotting the relationship between angle and strain for an arbitrary weight, a graph

resembling two parabolic arches exists. These parabolas intersect at an angle equal to 180
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coefficients can be calculated to make the set of equations true. This system is given by

the following equations:

The coefficients for this system of equations can easily be calculated using Cramer’s rule.

However, since data was collected at various torques, the coefficients for each set of data

must be averaged in order to accurately calculate these values at arbitrary strains. Once a

range of torques has been selected, the starting and ending torques can be defined as 

and  respectively. The following equation is then used to calculate the two final

coefficients at a defined angle:

These coefficients are then used in the following equation to calculate the torque for

arbitrary strains on defined channels   and  at a defined angle:

This method is very efficient because the calculated coefficients apply to both the large

and small chainrings. Averaging the coefficients over the variable torque range appears to

produce minimal error as well. The only downfall of this system is that it does not utilize

all of the available channels.

Parallel Derivatives

It is known that the relationship between the torque and strain at a defined angle is linear,

and also that zero strain will be measured with zero torque, causing a plot of this data to

intersect at the origin. Therefore, one can easily multiply an arbitrary strain for a defined
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7. Secure the RWBG wire so that it cannot pull the wiring junction off.

Reed Switches

Reed switches are glass tubes with a set of contacts inside.  Reed switches can be

normally open or normally closed.  When a magnet or an electromagnet passes in

the vicinity of the reed switch it either closes or opens based on the type of

switch.   For this circuit it is preferred to use a switch that is normally open to

reduce the power consumption of the circuit.  The black wire of the reed switch

assembly is connected to a high voltage through a resistor to manage the current

and when the reed switches pass by the magnet they close and bring the input up

at the PIC.  There is a green reed switch collocated with the right crank arm that is

position 0 and is connected via a green wire to a dedicated PIC input.  The

remaining 7 reed switches are connected to a separate input on the PIC via a blue

wire.

Calculation Procedures

There are currently three independent methods to calculate various coefficients for our

bicycle crankset:

System of Equations

When two independent channels are used in a system of equations, coefficients can be

calculated to fit the data between the large and small chainrings. Using arbitrary channels

 and , two equations can be formulated which express the torques exerted on both the

large and small chainrings. Since the strains on both channels  and  are unknown, two
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Soldering Strain Gauge Wires

1. Prep the wires.

a. Cut sets of 8 wires to the exact same length for each Wheatstone

bridge.

b. Strip both ends of each wire by placing between the soldering tip and

the solder until the wire is in a drop of solder.

c. Wait for the solder to melt the insulation.

d. Trim the exposed wire to the length of the tab that it will be applied to.

2. Clean surfaces to be soldered with Eraser to remove any oxide layer.

3. Apply a small amount of Flux to the surface to be soldered and apply a bead

of solder to the Strain Gage tabs and to the Wiring junction tabs.

4. Solder one end of each wire to the strain Gauges.

5. Solder the other end of each wire to the Wiring Junction.

a. Solder either tension or compression strain gauges first.

b. Check the resistance, two tabs connected to one strain gauge should

give the resistance of the strain gauge, two connected to different

strain gages should give an infinite resistance.

c. Apply an epoxy to the first set of wires so that when the second set is

applied the first set stays in place.

d. Check the resistances, should get the resistance of a strain gauge or

(1/R + 1/3R)^(-1).

e. Apply the epoxy to the second set of wires.

6. Solder the Red, White, Black, Green wire to the wiring junction.
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a. Take about a 2-inch piece of Mylar tape.

b. Stick one end of the tape next to the gage.

c. Slide thumb firmly and quickly along the tape over the gauge.  This is

done to avoid static electricity.

d. Peel the tape slowly, at a very low angle to the case, until it is past the

gage.  Then pull the rest of the tape off.

e. Apply the strain gauge to the sanded surface. Peel the tape back slowly

similarly to step d.  Peel just past the gauge.

f. Apply a very thin layer of drying catalyst (Xylene in student kit) to the

bottom surface of the strain gage.  Before applying to the strain gage wipe

the brush of the catalyst on the top of the jar 10 times.  Then apply the

catalyst to the bottom of the strain gage.  Let this dry for 1 minute on the

strain gauge.

g. Place 1 drop of super glue on the sanded surface directly beneath the

strain gauge.  Then quickly run thumb firmly over the tape and gage.

Press and hold for approximately 1 minute.  A piece of gauze should be

used to do this so hands do not get super glue on them.  (There is better

glue that can be used for longer life)

h. Peel off the tape back onto itself.  Peel off at an angle of almost 180

degrees.

i. Cover the gauge completely with a piece of Mylar tape until ready for

soldering.

j. Once ready for soldering, peel off the tape and reapply so that one edge

just overlaps the soldering points.
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a. Add mild acid (Phosphoric acid-red top bottle in student kit) to the end

of 400-grit sandpaper.  Shake of the excess acid on the sandpaper.  Sand

the surface.  Sand an area slightly larger than the strain gauge.

b. Use gauze and wipe from the center, of the sanded surface, out to one

side, then fold the gauze and wipe from the center to the other side of the

sanded surface.  Be sure to throw away the gauze.

c. Add mild acid to a Q-tip.  Shake of the excess acid.  Clean the surface in

a circular motion with the Q-tip.  Start from the center and work way out.

If the   Q-tip gets too dirty, throw it away and continue process with new

Q-tip.

d. Repeat step b

e. Add neutralizer (Ammonia water-blue top bottle in student kit) to a Q-

tip.  Shake of the excess.  Clean the surface in a circular motion.  Start

from the center and work way out.

f. Repeat step b

2.  Gauge Preparation

a. Add neutralizer to a piece of gauze.  Clean the surface of the plastic

strain gage case with the gauze.

b. Use gauze and wipe from the center out to one side, then fold the gauze

and wipe from the center to the other side.

c. Use tweezers to take gauge out of its package.  Grab near the soldering

points.  Carefully place on the top of the case.  Do the same for the

soldering tabs.

3.  Gluing
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the dropdown, click the New button, and add the following directory:

C:/<path to MCC18>/lib/

Assuming you’ve chosen the default installation directory, this location should

simply be:

C:/MCC18/lib/

Apply the settings, and the project should be ready for building.

Compiling the Code

To build the code, simply click the “Make” button on the toolbar (or

“Make All” if you wish to rebuild the entire project). Be sure to select the proper

build type from the dropdown on the toolbar (DEBUG if the ICD-3 debugger is

going to be used on the chip, and RELEASE if the final version of the code is to

be programmed into the chip).

Mechanical Documentation

Strain Gauge Application

1.  Prepare the Surface
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Setting up MPLAB IDE for compilation

There are several configuration issues encountered when setting up

MPLAB IDE for use on the PIC18LF2331 using C compilation. Please refer to

the introduction of this section for information on obtaining the proper software.

Once the software is installed, a project must be either created or opened.

If the project already exists, simply double-clicking on the project icon should

open up the project and be ready for editing and compilation. This is the situation

in most cases.

If, however, a new project is created, the following steps must be

followed. First, a new project should be created with the project wizard found in

the Project->Project Wizard menu item. The PIC18F2331 should be selected as

the Device. In the next dialog, the wizard asks for Toolsuite. First make sure that

the Microchip C18 Toolsuite is selected in the “Active Toolsuites” dropdown,

then select the MPLAB C18 C Compiler (mcc18.exe) in the Toolsuite Contents

menu. Then click next, give the project a name and location, and click next again.

In this final dialog you can add any existing files to the project. Once complete,

MPLAB IDE should open your project.

Before compilation for the 2331 will work (assuming you’ve added the

proper header files) you will need to ensure the linker knows where the object

files for the libraries reside. To do this, select the Project->Build Options->Project

item from the menu, click on the Directories tab, select Library Search Path from
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maximum voltage with open switches is 0.1V.

ANT+ Communication

ANT+ (version 3) is a wireless communications protocol created and

offered to developers by Garmin. Although it is not certified by the FCC for

consumer products, it is an easy way to implement wireless communications in a

laboratory setting and is compatible with the Garmin 705e used for the user

display unit.

The ANT+ development kit (ANT-DKT-3) comes with several

components. Currently the circuit uses one of the wireless transceiver modules to

communicate with the Garmin display unit. Also available are USB transceivers

that can be plugged directly into a computer and used for debugging.

Microprocessor Programming and Operation

The microprocessor used in this circuit design is the PIC18LF2331. The

development environment used is the MPLAB IDE, currently available at

http://www.microchip.com/stellent/idcplg?IdcService=SS_GET_PAGE&nodeId=1406&

dDocName=en019469&part=SW007002 for free download. In addition to this IDE, the

MPLAB C Compiler for PIC18 MCU’s (MCC18) must be downloaded and installed. It is

currently available at

http://www.microchip.com/stellent/idcplg?IdcService=SS_GET_PAGE&nodeId=1406&

dDocName=en010014&part=sw006011.
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Signal Amplification

The maximum level of the signals is approximately 400µV.  The INA122

instrumentation amplifier has an adjustable gain controlled by the gain resistor

RG, here set to 914.  Gain is set by the following equation, which can be found in

the datasheet:
G
R

k
G

!
+=
200

5

Cadence Sensor

Magnetic reed switches are employed to determine the angular position of

the crank.  The switches are normally open and close when they are near enough

to a magnetic field.  To determine the angular position there are 8 switches on the

crank set positioned 45°apart.  One is connected to a digital input pin on the

microcontroller, while the other 7 are connected in parallel to another digital input

pin.  The isolated switch is used as a 0°reference.

The switches connect the +3V signal to the respective input pin when

magnetized.  The 100k_ resistor to ground provides a load when the pin goes

high.  When the switches are open, there is 0 potential at the input pin, and when

they close it goes high to +3V.

The resistors were chosen as 100k_ because the higher the impedance,

the less power they consume.  However, the voltage at the input of the

microprocessor must be less than 0.45V for a logic low (per parameter D030 of

the PIC18LF2331 datasheet).  The leakage current is around 1µA, so the
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Other parts

20 MHz Crystal SMD [Y1]

http://search.digikey.com/scripts/DkSearch/dksus.dll?Detail&name=XC1254CT-

ND

Circuit design considerations

The general operation and notable design decisions of the various parts of the sub-

circuits are detailed in this section.

Strain Gauge Power Supply

The strain gauges are powered by a fixed 1V signal from the precision

voltage regulator LP3879.  1V was chosen because it simplifies calculations later

in the microprocessor.  When looking for the voltage differential in a bridge, the

microprocessor takes the V/V strain signal and multiplies it by the bridge input

voltage, so multiplying by 1.00 allows the processor to assume that calculation.

Input Signal Switching

There are 8 low-voltage signals coming from the four bridges.  The circuit

makes use of only one signal amplifier to save space and cost.  In order to do this,

the octal switch ADG714 connects them to the microprocessor one at a time.  It is

controlled by the microprocessor via the SPI interface.
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Resistors

Designator Value Size Manufacturer Supplier

R1 220 ! 1/8 W, SMD 1206 KOA Speer Mouser

R2 47 k! 1/8 W, SMD 1206 Vishay Mouser

R3 47 ! 1/8 W, SMD 1206 Vishay Mouser

R4 10 k! 1/8 W, SMD 1206 KOA Speer Mouser

R5

R6

R7

R8

100 k! 1/8 W, SMD 1206 Xicon Mouser

Capacitors

Designator Value Size Manufacturer Supplier

C1 4.7 uF 50V, SMD 1206 Murata Mouser

C2 10 nF 50V, SMD 1206 TDK Mouser

C3 10 uF 50V, SMD 1206 Kemet Mouser

C4

C5

C6

C7

C10

C11

100 nF 50V, SMD 1206 Kemet Mouser

C8

C9

18 pF 50V, SMD 1206 Murata Mouser
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Off The Shelf Components

System Function Product

Human-Interface Display (HID) Garmin Edge 705

Wireless Data Transmission (circuit->HID) ANT+ Development Kit: ANT-DKT-3

Microprocessor Debugger MPLAB ICD2

Power Source

3V Coin Cell Lithium Battery

http://search.digikey.com/scripts/DkSearch/dksus.dll?Detail&name=P028-ND

Integrated Circuits

Designator Part # Manufacturer Package Supplier

U1 LP3879 National Semiconductor PSOP-8 DigiKey

U2 ADG714 Analog Devices TSSOP-24 DigiKey

U3 INA122 Burr-Brown / TI PSOP-8 DigiKey

U4 LMP7702 National Semiconductor SOIC-8 DigiKey

U5 PIC18LF2331 Microchip SOIC-28 DigiKey

Connectors

MOLEX 52991-0208 [CONN3]

http://search.digikey.com/scripts/DkSearch/dksus.dll?vendor=0&keywords=WM2

4007-ND
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FSM of general system operation

Components List

This section outlines the components that are used in the current system. We have

done our best to provide information for obtaining new sets of components.
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Finite State Machines

This is a list of finite state machines representing the operation of the circuit. All

of the logic in the circuit takes place within the microprocessor. The various other

hardware is used for data acquisition, signal clean-up and amplification, and wireless data

transmission. The state machines below, in general, describe the operation of the

microprocessor; however there exist transitions generated by hardware outside of the

micro

General System Operation

The system operates in a very simple loop. First the system is calibrated.

Once this is complete, the system waits for the 0th switch on the crankset to pass

the sensor.
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Flow Chart of Microprocessor Operation
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Microprocessor Operation

Below is a diagram that illustrates the basic operation of the

microprocessor. This is the main logic of the system, gluing together the various

functions of the circuit to produce output.
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Budget

Item Price

Carbon Fiber Crankset $350.00

Electrical Components and Tools $400.00

Bicycle Repairs $50.00

Storage Units $40.00

Bike Lock and Pump $100.00

Electronics Documentation

Flow Charts

Mark Rhodes
Team Leader

Jeffrey Aigner
Sub-team Leader

Brian Albee
Sub-team Leader

Nick Gaulin

Jeonghun Lee

Seunggeun Lee

Yoshio Piediscalzi David Rowell

Yuriy Sizyuk

Jonathan Swanson
Sub-team Leader

Electrical TeamMechanical Team Visual Team
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a PCB layout.  The team was able to complete the task by increasing the number of layers

from two to four.  Unfortunately, the PCB layout and new housing were not completed in

time to test before the end of the project.  Additionally the electrical was unable to

configure the ANT+ communication with the cyclocomputer to test the circuits, however

a workaround with a slip ring was created so that mechanical testing could be performed

with the use of a model circuit and oscilloscope.  The slip ring allows wires to be run

from the bicycle to external components and equipment without becoming tangled on the

bicycle.  The circuit and power measurement were tested for operation but not accuracy,

demonstrating that the system works in principle.

Conclusions and Recommendations

Based on the results obtained, it is recommended that the new circuit design and

housing are completed so the system can be used in road tests. Future teams will have to

debug the current microprocessor code to provide accuracy and wireless capabilities,

manufacture the new housing unit, and explore other innovations within the current

systems limitations. The completion of these tasks will allow for a complete road test of

the system, and future consumer market research.

Appendices

Team Members and Team Structure
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through The Institute of Electrical and Electronics Engineers publications in order to

optimize the circuitry for interference reduction, stability, and power management.

Power management is an especially important design consideration for the electrical

team, by reducing the power consumption batteries need to be replaced less frequently

reducing the environmental impact.  The mechanical team retested an aluminum crank-

set from previous semesters in order to calculate the correct coefficients for use in the

microcontroller code.  Additionally, a new carbon fiber crank-set was obtained and static

testing was performed on the crank-set in order to determine the torque versus strain

relationship.  This was done to meet the demands of cyclists using a crank set made from

these two popular materials.  At the completion of static testing all three teams

contributed to dynamic testing of the carbon fiber crank-set.  This was accomplished by

collecting data while riding the bicycle on a Computrainer©, which provides an

independent and accurate power output of the bicycle. This data can then be compared

with data collected by our new power measurement system and checked for accuracy.

The visual team assisted the electrical and mechanical teams by researching component

prices, availability, and coordinating the groups’ supply needs.

Analysis and Findings

The electrical, mechanical and visual teams worked together to create an updated

prototype design, allowing for universal application of the device to road bicycles and

preventing interference in the operation of the bicycle.  The visual team designed a new,

universal housing while the electrical team designed a new printed circuit board (PCB)

layout which implemented interference prevention.  The circular shape for the circuit

board presented problems for the electrical team as they had not previously designed such
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market are very expensive ($800 and up) and not universal. Our IPRO worked on

providing a much less expensive solution to the problem using the method of measuring

strain in the crank set of a bicycle. Based on our findings the system works in principle

but requires more work to finalize and test.

Purpose and Objectives

Competitive cyclists want an accurate measurement of their training progress.

Historically cyclists have used heart rate data along with mileage and speed to provide a

measurement of how hard the athlete is working during training.  The problem is that an

individual’s heart rate can be affected by sleep patterns, eating patterns, stress, time of

day, and other factors independent of the amount of power the athlete produces.  Also,

the time taken to complete a course can be affected by wind and terrain.  Therefore, a

better method has been devised to accurately measure the amount of power the cyclist

produces during a training session.  There are currently several commercially available

products, priced between $800-$3000 USD per unit, that measure a cyclist’s power

output within 2% accuracy.  These prices are perfectly acceptable for professional,

sponsored cyclists but are prohibitive for many other cyclists.  The goal of this IPRO is to

continue the development of a new low cost power measurement system that is as

accurate as those currently available.  This new system uses the measurement of strain in

the crank spider along with cadence (RPM) data to calculate power output.

Organization and Approach

The team was divided into three sub-teams: electrical, mechanical and visual to

achieve the IPRO’s goal.  The electrical team researched good circuit design practices
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Executive Summary

Power output is the most accurate measurement of a cyclist’s performance. As a

result devices that can provide this information can become a valuable tool for

professional athletes and amateurs alike. However, these kind of devices currently on the
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